
WGIF 1.1a
Introduction

WGIF is a freeware program to display pictures that conform to the GIF87a standard under 
Microsoft Windows 3.X.  I created it because I couldn't believe that every existing GIF display 
program I could find for Windows had a shareware price tag and also because I needed a vehicle
to begin learning about the display of bitmaps under Windows, scroll bars, menus, etc.

If you want to write me for some reason (and that reason does not involve me sending you a 
disk with something on it) then my address is:

Bells and Whistles Software
3829 Lawndale Ave.
Ft. Worth, TX  76133

or you can contact me via my CompuServe account:

73527,2544

I'm always open to suggestions for improvements, new program ideas, hate mail, and disks 
full of those half finished programs you've been working on.

A Note From The Author To Other Authors
And now a moment on my soapbox...  Much to my disappointment WGIF is still the only 

freeware GIF viewer a year after it was first released.  I cannot tell you how sad it is to see that 
virtually all Windows programs issued by small programmers have a price tag attached to them.  
This is regardless of the length of time spent coding, the quality of the program, or the amount 
spent to develop the program.  At one time I believed that this was due to the high cost of 
developing for Windows (Borland C++ set me back $387 when I bought it), those hopes were 
dashed when inexpensive development with Visual Basic and Turbo C++ for Windows just 
brought a flood of pathetic gimme gimme programs.  Fellow programmers, get a clue.  Your 
audience spent $80 or less to buy Windows in the first place, do you feel that you are justified in 
charging $35 for a program that puts yellow sticky notes around the screen?  When the users get 
charged for every trivial thing in sight, their response will be to not pay for any of it, good or bad, 
big or small.  Ease up or you will never get a dime even if you write something worth paying for.

Please note that these are the views of one author and may not reflect the views of all who 
write software released under the Bells and Whistles Software label.

Features
WGIF is currently the 2nd fastest GIF display program I've seen for Microsoft Windows 3.0 or 

3.1.  This speed would not have been possible if not for the excellent LZW decoding routines of 
Steven A. Bennett, many thanks to him.  It is also the only GIF display program at this time that 
takes advantage of the common dialog boxes or drag and drop capabilities of Windows 3.1.  At 
one time WGIF was the fastest but ShowGIF is now even faster, if you want to pay for the speed 
difference, be my guest.

You can use File Manager's ability to associate programs with file extensions so that you can 
double click on a GIF file listed in a File Manager window and WGIF will open and begin 
displaying the picture.  WGIF can also play a role in OLE, see below for hints on how to use 
WGIF with your OLE capable programs.

Windows 3.1 users can take advantage of WGIF's support for drag and drop.  Just drag a 
GIF file from File Manager to WGIF's window or icon and it will begin decoding it.



It remembers any option settings (like dithering preferences) you may have from one session 
to the next.

It's also free...  However, WGIF is only freeware and NOT public domain software.  You can 
give copies of it to all your friends (or your enemies if you don't like it) but you can't sell it or claim 
that you wrote it.

Non-Features
GIF89a format is not yet supported (hardly a big deal yet).

No clipboard support.

Ordered is the only dithering option (and although it's quick, it's not very pretty).

It's actually bigger than WinGIF even though WGIF does less.  Go figure.

You can't save a GIF file as a BMP, DIB, TIFF, RIFF, BIFF, WHIM, or WHAM file.



Legal Swill
Everybody has advised me that there are people out there who will sue even when they have 

no reasonable case and that I need this protection.  So, unfortunately I am going to have to 
include it and your use of the program will be governed by it.  If you do not read, understand, and 
agree to this, YOU CANNOT USE THIS PROGRAM.

Bells and Whistles Software specifically disclaims all warranties, express or implied, including
but not limited to, any implied warranty of fitness for a particular purpose.  In no event will Bells 
and Whistles Software incur any liability for damages, including but not limited to, loss of profit, 
data or use of the software, or special, incidental or consequential damages or other similar 
claims, even if Bells and Whistles Software has been specifically advised of the possibility of such
damages.

This license shall be construed, interpreted, and governed by the laws of the State of Texas 
and any action hereunder shall be brought only in Texas.  If any provision is found void, invalid, or
unenforceable it will not affect the validity of the balance of this Licence and Limited Warranty 
which shall remain valid and enforceable according to its terms.

What that all boils down to, is this...  I'm giving something to you for free.  I tested it as best I 
could and I believe that it can do you no harm even if you use it in an absolutely moronic way.  
But, if you have a lightning strike at your house and WGIF gets corrupted and instead of crashing 
it starts playing obscene limericks through your PC's speaker, you can't hold me responsible.  
This program has no warranty.



Installation
The only installation necessary for WGIF is to make sure that the file WINSUPP.DLL appears 

in the path.  I suggest copying it to your Windows directory.

Using WGIF
WGIF is simple enough at this time that a thorough explanation of the menu items that make 

up its commands, plus a basic understanding of how to operate a Windows 3.X program should 
be enough to operate the program.  I am assuming that you already have the understanding of 
how to run Windows programs from reading Microsoft's documentation and playing around with 
the programs that are bundled with Windows (like Write and Paint).

WGIF has three menus: File, Options, and Help.  I'll address them in order.

File/New
If this command is displayed in a light gray color then it cannot be performed because 
you do not have a GIF file displayed at this time.  If you do have a GIF file displayed and 
you select this command, the screen will be cleared and the GIF file will be dumped from 
memory.

File/Open...
Brings up a standard Windows file selection dialog box.  Find the GIF that you want 
to display and select it.  After selecting a file WGIF will attempt to load and display 
that file.

File/Reload
This command is normally displayed in a light gray color which indicates that it 
cannot be performed.  However, whenever you change an option which would 
change the appearance of a currently displayed picture then you can use this 
command to reload the same picture that was last loaded and display it with the new 
option(s).

Currently, the only way to make this command available is to change the dithering 
method used when displaying a picture (see Options/Dithering below).

File/Exit
Saves your current option selections and leaves the program.

Options/Dithering
This option shows a small arrow out to the right of it to indicate that it has a sub-menu
with various dithering choices on it.  The only two options at this time are None, 
which performs no dithering, and Ordered which performs a very high speed form of 
dithering with mediocre visual quality.  The option with a check mark beside it is the 
currently selected dithering method.

If you have Windows running in 256 colors then you should leave dithering set to 
None, if you only have 16 colors then you should try Ordered dithering.

Note:  Changing this option will not affect any currently displayed picture.  It affects 
the next picture Opened or Reloaded.  If you want to see a currently displayed 
picture with another dithering method, select the method and then select Reload 
from the File menu.

Options/Decode To Screen
If this option is selected (as indicated with a checkmark to the left of it) then WGIF will
display the lines of the GIF file as it decodes them.  If any of the lines that are 



displayed this way are destroyed (for example, by moving another window over them)
then they will not be redrawn until the entire GIF has been decoded.

Options/Minimize On Decoding
If you would rather the program just got out of your way while it decodes that big GIF 
file then this option is for you.  It will automatically minimize WGIF's window when it 
starts decoding a GIF file and you can tell when the program is done with the 
decoding process because the name of the GIF file will appear in the icon's caption.

Help/Contents
Brings up the contents page of the help file.

Help/Glossary
Brings up a glossary page that defines a variety of terms that you may not be familiar 
with.  If you encounter a word in the program or the help file that is strange to you, see if 
this page has a definition.

Help/How To Use Help
Brings up a special help file that is devoted to explaining how to use the Microsoft 
Windows 3.1 help program.

Help/About WGIF...
Displays a dialog box that tells you the version number of the WGIF that you are running 
and various legal swill that I have to put in my program to protect myself.

Using WGIF with File Manager
If you would like to set up File Manager to use WGIF for automatic display of GIF files then 

you will need to consult your Windows documentation on the subject of "Associating Documents 
with an Application" (p. 135 in my copy of the Windows User's Guide).  Select a file ending 
with .GIF and type in the path to WGIF in the dialog box that File Manager offers for the 
association.

Using WGIF with OLE
If you have set up File Manager to use WGIF as described above then you can 

perform a drag and drop of a GIF file from File Manager to an OLE client application 
(like Write, Microsoft 
Word, Ami Pro, and more to come).  When the file is dropped a copy of the file will be 
embedding into the open file of the OLE client and the icon for WGIF will normally 
appear in the 
document.  When you double click on that icon WGIF will run and will load the 
picture.

Note:  When I said embedded, I meant embedded.  A 189K GIF file that is added to a 
Write file 
in this way will expand the size of that Write file by an extra 189K.  This can be very 
handy 
because all you need to hand to somebody else is the Write file and you don't have to
remember 
all the pictures to give them as well, all they need to have is a copy of WGIF and your
document 
with the embedded pictures and they can look at your illustrations.  It can also make 
a document 
too large to fit on a single disk if you go overboard with it.

Using WGIF with OLE (Advanced OLE Users Only)



Object Packager is a program which you may not have used yet but it is an extremely 
powerful way to use OLE with programs that were not written to be OLE servers (like WGIF).  
Run Object Packager (it's in your Accessories group under Program Manager).  Then select 
Command Line from the Edit menu and enter a command line that you would like to run when 
this package's icon is double clicked.  An example might be "WGIF ZOE.GIF", this would run 
WGIF when the icon is double clicked upon and WGIF will attempt to load the file ZOE.GIF from 
the current directory.  Now you need to click on the Insert Icon button and find an icon that you 
like, you may even choose to Browse and locate and insert WGIF's icon for the package.  You 
can now select Copy Package from the Edit menu and you will have a package that you can 
paste into any OLE client application.  This method of using WGIF does not embed the GIF file 
into the OLE client's file, instead the small command line package will be embedded.  That means
that any GIF files will need to be copied along with the file that uses them.  WGIF will issue an 
error message if it cannot find a file when it is told to load that file specifically on its command 
line.

Note:  Obviously, this method of using OLE is very susceptible to problems with paths.  If all the 
files aren't in the same directory or if you have explicit paths on the command line (i.e. "C:\GIF\
ZOE.GIF") and the files aren't in the specified directory then you are going to have errors.  If you 
can get away with a size expansion of the OLE client's file then the first method of using OLE is 
definitely the easier.

Glossary
dithering is a way to trade off resolution and/or clarity in a picture for an appearance of 

more colors.  WGIF uses dithering in an attempt to make pictures with large 
numbers of colors (e.g. 256) look better on displays with fewer colors (e.g. a 
basic VGA card with 16 colors under Windows).

freeware is software which has no fee associated with using it.  This is NOT the same as 
public domain software.

GIF (pronounced jif) is a Graphics Interchange Format created by CompuServe Inc. 
as a means of transferring pictures among a variety of microcomputers in a 
device independent manner and with significant compression of the images to 
reduce their size.

public domain software is software which has no owner and is available for you to 'do as 
thou wilt' with.  You can sell it, include it with your own software, 
etc.

shareware is software which can be tried out before you pay for it.  Most shareware has a 
specific trial period associated with it and after that trial period is over you must 
either pay the author for the software or cease using the software.

Revision History
1.0a First released version.
1.0b Fixed bugs that caused scroll bars to appear at inappropriate times and with 

inappropriate scroll ranges.  All the bugs fixed were related to minimizing and 
maximizing the window.
The problem with running multiple copies of WGIF seems to have gone away 
when I changed compilers from Zortech C++ to Borland C++.
Added an alternate icon that you can choose to display in Program Manager.
I managed to shrink its size on disk by a few K.

1.1a Added drag and drop support for Windows 3.1 users.
Swapped my old file open dialog for the new Windows 3.1 common dialog box.
Added online help for Windows 3.1.


